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ISO/IEC 27000-series ISC

e La serie ISO/IEC 27000 - Information security management systems
raggruppa un insieme di norme che hanno lo scopo di proteggere le
informazioni che vengono mantenute ed elaborate da
un’organizzazione.

» Attraverso questa famiglia di standard, le organizzazioni possono
sviluppare ed implementare un proprio framework per la gestione della
sicurezza delle proprie risorse informative.

* Le informazioni vengono protette da possibili attacchi informatici,
errori umani, calamita naturali o da qualsiasi altra vulnerabilita che si
puo presentare durante |’utilizzo di un sistema informatico.

« Data la natura dinamica del rischio e della sicurezza delle informazioni,
il ISMS incorpora un feedback continuo e attivita di miglioramento per
rispondere ai cambiamenti delle minacce, delle vulnerabilita o degli
impatti degli incidenti.
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ISO/IEC 27037 i

Lo standard 27037 dal titolo “Guidelines for identification, collection,
acquisition, and preservation of digital evidence” fornisce delle linee
guida relative alla gestione delle potenziali prove digitali,
concentrandosi in particolar modo sulle
fasi di identificazione, raccolta,
acquisizione e preservazione.

Identificazione

Per ogni fase vengono indicate

le best practices riconosciute

per permettere che la potenziale
prova possa essere utilizzata
efficacemente in sede processuale,
tenendo conto delle possibili

(e piu comuni) situazioni che
I’investigatore puo trovarsi

a dover affrontare.

PROCESS OF DIGITAL FORENSICS




ISO/IEC 27037-key role ISC

Vengono inoltre definite tre figure chiave, che si occupano e sono
responsabili degli aspetti di gestione della prova digitale menzionati sopra:

1. il DEFR o Digital Evidence First Responder e un soggetto autorizzato,
formato e qualificato ad agire per primo sulla scena di un incidente per
eseguire attivita di raccolta ed acquisizione delle prove avendone
inoltre la responsabilita di corretta gestione

2. il DES o Digital Evidence Specialist € un soggetto che ha le capacita di
eseguire le stesse attivita eseguite da un DEFR ed in piu possiede
conoscenze specialistiche ed e in grado di gestire una moltitudine di
problematiche tecniche, ad esempio € in grado di portare a termine
attivita quali acquisizione di rete, di memoria RAM ed ha ampia
conoscenza di sistemi operativi e/o Mainframe

3. l’Incident Response Specialist, che normalmente € una figura
professionale interna all’azienda che si occupa del primo intervento
post incidente informatico.




S0/1EC 27042 isofll (.

La ISO/IEC 27042 «Guidelines for the analysis and interpretation of
digital evidence” fornisce una guida sull'analisi e linterpretazione delle
prove digitali in grado di affrontare le questioni di continuita, validita,
riproducibilita e ripetibilita.

Include le migliori pratiche per la selezione, la progettazione e

'attuazione dei processi analitici e la registrazione delle informazioni per
consentire a tali processi di essere sottoposti a controllo indipendente.

Fornisce indicazioni sui meccanismi appropriati per dimostrare le
competenze del gruppo investigativo.

Fornisce un framework, per gli elementi analitici e interpretativi della
gestione degli incidenti di sicurezza dei sistemi di informazione, che puo
essere utilizzato per assistere nellimplementazione di nuovi metodi e
fornire uno standard minimo comune per le prove digitali prodotte da tali

attivita.



1SO/IEC 27050 1sofll {

|’Electronic discovery e il processo che consente di scoprire le
informazioni memorizzate elettronicamente (ESI) pertinenti ad una o piu
parti coinvolte in unindagine o in un contenzioso, o procedimento simile.

La ISO/IEC 27050 fornisce una panoramica della Electronic discovery.
Inoltre, definisce i termini correlati e descrive i concetti, inclusi, ma non
limitati per l’identificazione, la conservazione, la raccolta,
’elaborazione, la revisione, ’analisi e la produzione di ESI.

La ISO/IEC 27050 e importante sia per il personale tecnico che non
tecnico coinvolto in alcune o tutte le attivita di electronic discovery. Le
linee guida presenti non si contrappongono alle leggi e normative locali,
pertanto l’utente deve prestare attenzione affinche le previsioni siano
conformi ai requisiti giurisdizionali prevalenti.
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la gestione del reperto informatico
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Raccolta

Acquisizione
Conservazione

Analisi e Interpretazione



Digital Forensics

Questa attivita e trasversale alle precedenti (“Scoperta e notifica”,
“Valutazione™) e consiste nella raccolta ed analisi dei reperti che possono
essere utilizzati al fine di documentare il fenomeno verificatosi e poter
perseguire 1 responsabili.

Affinche le prove estrapolate dai reperti possano essere utilizzabili in sede
processuale e bene adottare una serie di linee guida.

Queste hanno il compito di:
» Definire i requisiti del reperto digitale
 Stabilire le fasi da seguire e [’obiettivo che si vuole raggiungere

* Individuare le figure professionali che gestiranno le evidenze digitali




Requisiti del reperto digitale

* Prova digitale

« Informazione o dato, memorizzato o trasmesso in formato binario, che puo essere
utilizzato come prova

e Copia di prova digitale

» Copia di prova digitale che puo essere prodotta per mantenere [’affidabilita della
prova, includendo sia la prova digitale che la procedura di verifica

 Dato volatile

» Dato facilmente soggetto a modifica. Una variazione puo essere dovuta ad assenza di
corrente o ad interventi di campi magnetici, a cambi di stato del sistema

» Alterazione
» Modifica del valore di potenziali evidenze digitali e riduzione del valore probatorio

 Distruzione di prova
* Modifica volontaria del valore di potenziali evidenze digitali




Requisiti del metodo forense

« Pertinenza
» Serve per incolpare (o discolpare)

« Dimostrare che il materiale e rilevante, cioe che contiene dati utili e che pertanto
esiste una buona ragione per acquisirli

 Affidabilita
» Assicurarsi che la prova digitale sia genuina

» Tutti i processi eseguiti devono essere ben documentati e, se possibile, ripetibili. Il
risultato dovrebbe essere riproducibile

 Sufficienza
» |l DEFR deve valutare quale materiale deve essere raccolto e le procedure idonee
|l materiale puo essere copiato o acquisito (sequestrato)
« Non e detto che sia sempre necessario acquisire una copia completa
» Valutare in base al caso (interessa la figura del DEFR)
« Puo dipende dalla legislazione nazionale




Requisiti del metodo forense

« Verificabilita
« Un terzo deve essere in grado di valutare le attivita svolte dal DEFR e dal DES
e Attuabile se esiste la documentazione delle azioni svolte

» Valutare il metodo scientifico, le tecniche e le procedure seguite
» DEFR e DES devono essere in grado di giustificare le azioni svolte

 Ripetibilita
» Le operazioni devono sempre essere ripetibili utilizzando le stesse procedure, lo
stesso metodo, gli stessi strumenti, sotto le stesse condizioni

 Riproducibilita

» Le operazioni possono essere ripetibili anche usando lo stesso metodo, gli strumenti
diversi, sotto condizioni diverse

« Giustificabilita
» Dimostrare che le scelte adoperate erano le migliori possibili
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La ISO/IEC 27037 indica le fasi che consento la raccolta delle evidenze:

 |dentificazione
» Raccolta
« Acquisizione
 Conservazione
Mentre la ISO/IEC 27042 si concentra sull’analisi delle evidenze:
« Analisi

 Interpretazione
|’ obiettivo finale consiste nella Presentazione dei risultati raggiunti.




|dentificazione

e La prova informatica si presenta in forma fisica e logica
e Device
» Rappresentazione dei dati

 Ricerca dei device che possono contenere dati rilevanti
o Priorita ai dati volatili

» Considerare dispositivi di difficile identificazione
» Geografica: Es.: Cloud computing, SAN

e Dimensioni Es.: miniSD

» Si considera computer un dispositivo digitale standalone che riceve, processa e
memorizza dati e produce risultati

e Non connesso in rete

 Ci possono essere periferiche connesse

« Se il computer ha un’interfaccia di rete, anche se non e connesso in rete al
momento dell’intervento, bisogna individuare gli eventuali sistemi con cui puo
aver comunicato




|dentificazione

La scena del crimine puo contenere diversi tipi di dispositivi di memorizzazione

» Hard disk, hard disk esterni, floppy disk
» Memorie flash, memory card, CD, DVD, Blu-ray

In fase di identificazione il DEFR deve:

Documentare marca, tipo e numero di serie di ogni supporto individuato. Inoltre, se i
supporti risultano danneggiati esternamente, deve documentare lo stato con ’ausilio di foto

Identificare tutti i computer e il loro stato (acceso/spento), che deve rimanere inalterato:
» stato acceso: documentare cosa € visibile sullo schermo (effettuando foto) e inserirlo a verbale
» stato spento: non effettuare alcuna operazione sul dispositivo.

Reperire i caricabatterie dei dispositivi alimentati a batteria, per evitare che possano
scaricarsi

Utilizzare un rilevatore di segnali wireless per verificare la presenza di dispositivi nascosti

In determinate situazioni puo essere molto utile prendere in considerazione anche evidenze
non digitali, come ad esempio informazioni sui dispositivi fornite da personale impiegato in
azienda (ad esempio: scopo di utilizzo del dispositivo, password per [’accesso, ecc. . . )




Raccolta (sequestro) o acquisizione?

Una volta terminata la fase di identificazione il DEFR, con gli strumenti in
SUO possesso, deve decidere se procedere con la raccolta o l’acquisizione.

Per prendere tale decisione vanno presi in considerazione alcuni fattori:
« volatilita della possibile evidenza

 esistenza di cifratura completa o parziale dei supporti (nel qual caso puo
essere utile effettuare |’acquisizione dei dati volatili in RAM)

« criticita del sistema (es. server che non puo essere spento poiché critico per
il business aziendale)

* requisiti legali

» carenza delle risorse necessarie (ad es. quantitativo di spazio necessario o
disponibilita del personale).




Raccolta : {6

Nel caso in cui si opti per il sequestro dei dispositivi, la modalita di
esecuzione della stessa dipende dallo stato in cui si trova il sistema.

« Sistema trovato spento
Nel caso in cui il sistema venga trovato spento, vanno prese in considerazione le
seguenti attivita:
» assicurarsi che il dispositivo sia effettivamente spento e non in standby
» rimuovere il cavo di alimentazione, staccando prima [’estremita connessa al
dispositivo e poi quella a muro

» disconnettere e assicurare tutti i cavi connessi al dispositivo ed etichettare le relative
porte a cui sono connessi, cosi da ricostruire le connessioni in seguito

» proteggere il tasto di accensione, onde evitare accensione casuale del dispositivo

* mettere in sicurezza eventuali alloggiamenti per floppy disk, cd/dvd con del nastro
per evitare apertura/espulsione del contenuto.




Raccolta

« Sistema trovato acceso
Nel caso in cui il sistema venga trovato accesso, vanno prese in considerazione le seguenti attivita:

» acquisire i dati volatili del dispositivo prima di spegnerlo, cosi da poter avere a disposizione
eventuali chiavi di crifratura residenti in memoria. Nel caso in cui si sospetti la presenza di
meccanismi di cifratura conviene procedere in seguito con acquisizione logica

» nel caso in cui si voglia lasciare il dispositivo acceso (ad esempio per presenza confermata di
meccanismi di cifratura), bisogna prestare particolare cura durante il trasporto (raffreddamento,
protezione da shock)

» nel caso in cui si decida di spegnere il dispositivo, valutare se sia il caso di effettuarlo mediante
regolare procedura di spegnimento o staccando il cavo di alimentazione (rimuovendo prima
|’estremita attaccata al dispositivo e poi quella attaccata alla presa). Normalmente tale decisione
dipende dalla configurazione del sistema

» etichettare e staccare tutti i cavi dal sistema. Etichettare tutte le porte cosi che lo stato del
sistema possa essere ricostruito in laboratorio

» proteggere il tasto di accensione, onde evitare una accensione casuale del dispositivo

» infine, nel caso tale dispositivo sia un notebook, acquisire i dati volatili prima di rimuovere
batteria e successivamente il cavo di alimentazione. Mettere in sicurezza anche eventuali
alloggiamenti per floppy disk, cd/dvd utilizzando del nastro.




Acquisizione

Nel caso in cui si opti per ’acquisizione dei dispositivi, sia on-site che in
laboratorio, la modalita di esecuzione della stessa dipende, allo stesso
modo della raccolta dallo stato in cui si trova il sistema.

» Sistema trovato acceso

Nel caso in cui il sistema venga trovato accesso, vanno prese in considerazione le seguenti attivita:

» acquisire tutti i dati volatili che verrebbero persi se il dispositivo venisse spento (es. RAM, processi
in esecuzione, connessioni di rete, impostazioni di data ed ora). Per effettuare ’acquisizione &
consigliabile riversare i dati copiati in un contenitore logico, calcolarne |’hash e documentarne il
valore. Ove cio non sia fattibile e possibile utilizzare un contenitore di tipo ZIP, calcolarne ’hash e
documentarlo

» iniziare il processo di copia forense dei dati non volatili utilizzando strumenti validati. La copia
forense ottenuta va memorizzata in un dispositivo preparato per tale scopo (es. Formattato). Se la
copia viene invece memorizzata in un contenitore logico bisogha assicurarsi che questa non possa
essere corrotta o danneggiata. Al termine del processo di copia calcolare e annotare il valore di
hash

» utilizzare una sorgente affidabile per documentare data e ora e documentare accuratamente
inizio e fine di oggi attivita




Acquisizione

« Sistema trovato spento

Nel caso in cui il sistema venga trovato spento, vanno prese in considerazione le seguenti attivita:

« assicurarsi che il sistema sia davvero spento

» rimuovere il supporto di memoria dal dispositivo spento (se non gia fatto), ed etichettarlo
accuratamente (es. Produttore, modello, numero di serie)

» eseguire la copia forense del supporto di memoria utilizzando un tool validato. Calcolarne il valore
di hash al termine.

» Sistemi critici

Un caso particolare nella fase di acquisizione si ha quando ci si trova davanti ad un sistema critico,
per cui per svariate ragioni non e possibile procedere all’acquisizione completa dei dati contenuti
all’interno del sistema. Alcuni esempi di tali sistemi sono data center, sistemi di sorveglianza o
sistemi medici. In tali situazioni vi sono due sole possibili alternative di acquisizione:

 acquisizione live (acquisizione totale della memoria RAM e di massa)

e acquisizione parziale (solo determinate porzioni di memoria di interesse investigativo):
il sistema di cui si vogliono acquisire i dati ha una capacita di memoria notevolmente grande, contenendo
quindi una mole notevole di dati (si pensi ai database server)
« il sistema, a causa della sua criticita, non puo essere spento
« solo alcuni dati sono rilevanti all’interno del sistema
» vi sono dei vincoli legali che consentono solo |’acquisizione di alcuni dati.




Acquisizione: classificazione

Per acquisizione forense del supporto di memorizzazione si intende [’estrazione del
contenuto memorizzato sotto forma di sequenza di bit memorizzati al suo interno.

Micro Read

[ -
IFIEFI'I

More Technical

Longer Analysis

Times | | Hex Dump / JTAG

More Training
Required

More Invasive _
Manual Extraction

"I,.

La copia forense ideale e una copia bit a bit del supporto originale perché include:
» Tutti i file, quelli cancellati, lo slack space, lo spazio libero



Acquisizione: write blocker

Per dare garanzia del rispetto dei principi enunciati, tutte le operazioni
eseguite in fase di acquisizione devono essere accuratamente
documentate, meglio se si utilizzando dei dispositivi che registrano
automaticamente quanto viene eseguito.

Se possibile e conveniente utilizzare anche dei dispositivi che impediscono
|’alterazione del supporto di origine: c.d. write-blocker
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Al termine della fase di acquisizione bisogna “sigillare” i dati acquisiti
attraverso un sigillo digitale (solitamente un impronta hash con l’eventuale
aggiunta dell’utilizzo di una firma digitale per associare ’operazione al
DEFR) per dimostrare che la copia ottenuta sia identica all’originale.

L'algoritmo di hash elabora una qualunque mole di bit e restituisce in output
una stringa di bit di dimensione fissa. L'output e detto digest.

e La stringa di output e univoca per ogni documento e ne e un identificatore

e L'algoritmo non e invertibile, ossia non e possibile ricostruire il documento
originale a partire dalla stringa che viene restituita in output (anche se in
realta per ogni digest esistono infiniti input che lo generano - cd. collisioni)

DPCM 8 febbraio 1999: “l'impronta di una sequenza di simboli binari € una
sequenza di simboli binari di lunghezza predefinita generata mediante
'applicazione alla prima di un‘opportuna funzione di hash“




Conservazione

Inoltre, occorre garantire che sia preservata, con i dovuti accorgimenti,
la confidenzialita, l’integrita e la disponibilita della potenziale prova.

’evidenza, infatti, va preservata sia durante il trasporto che lo
stoccaggio, che potrebbe superare il suo tempo di vita a seconda dei
tempi di giustizia.

Per far cio occorre:

» Etichettare tutto

» Verificare che le batterie siano opportunamente caricate (e ricaricare)

» Bloccare parti mobili

« Ridurre rischi in base alla natura del supporto

« Ridurre rischi dovuti al trasporto

 Preservare eventuali altri tracce
 Es.: tracce biologiche

« Utilizzare guanti puliti



Conservazione: catena di custodia

Catena di custodia

Documentare movimenti e interazioni
con la potenziale prova digitale

Storia del supporto a partire
dalla fase di raccolta

Formato cartaceo o digitale

Deve contenere
» |dentificativo unico dell’evidenza

» Quando, dove, chi e perché ha
avuto accesso all’evidenza

» Documentare e giustificare
ogni alterazione inevitabile,
con il nome del responsabile

EVIDENCE

| Submitting Agency

f Date Collected

Item #

Collected By

Description of Evidence
Location Where Collected

Type of Offense

CHAIN OF CUSTODY

| Rec.From By

| Date Time

| Rec.From By

Date
Rec. From

Date




Analisi

L’analisi deve consentire la ricostruzione degli eventi passati attraverso la
lettura dei dati rinvenuti.

Poichée ogni copia coincide con [’originale, [’analisi va eseguita su una copia
dei dati acquisiti e non sull’originale

Caratteristiche dell’analisi

» Riproducibilita: Ogni singola operazione deve produrre sempre lo stesso risultato
(si intende risultato oggettivo, cioe i dati e non la loro valutazione)

« Metodologie: si puo applicare la Regola delle 5W
« WHO? («Chi?»)
» WHAT? («Che cosa?»)
» WHEN? («Quando?»)
 WHERE? («Dove?»)
e WHY? («Perché?»)




Analisi: metodologia

Che cosa e successo e come si e svolto? _ _.
Individuare i dati utili a ricostruire | fatti * Quante volte si e verificato?

» Comunicazioni « Comunicazioni
» Documenti « Documenti
° Log 2 Log
» Metadati (date, luoghi, coordinate...) * Metadati (date...)
* Chi e coinvolto? « C’era consapevolezza?
« Comunicazioni « Comunicazioni
/ * Documenti
* Quando e accaduto? . Log
» Comunicazioni . « Metadati (date...)
+ Metadati (date, utenti) - Navigazione web

e Da dove a dove? » Competenze utente

« Comunicazioni

 Documenti

 Log

» Metadati (date, luoghi, coordinate...)
» Tabulati telefonici




Analisi: strategie operative

* Ricerche
* Autore
* Intervallo di date
» Tipo di file
« Parola chiave
* Per hash
» Per thread (email)

« Recupero dati

» Recupero dati cancellati, carving...
 |Interpretazione dati
» Conversione tra formati

» Crack password
» File tipicamente protetti
» Tipologie di attacco

» Artefatti del sistema operativo




Analisi: carving

Il data carving e un processo di
estrazione di un set di dati da un
insieme di dati molto piu ampio.

La tecnica del data carving e
utilizzata solitamente durante le
indagini di analisi forense per
analizzare lo spazio non allocato.

Durante questo procedimento e
ignorata la struttura del file system.

| file sono individuati e catalogati in
base all’header e al footer trovato.

Distinguiamo
« Data carving base

» |’header e footer dei file non sono
sovrascritti

« |l file non e frammentato
|l file non & compresso

« |l file estratto e l’insieme di bit contenuti tra
header e footer

e Data carving avanzato
| frammenti non sono sequenziali
» | frammenti non sono ordinati

« Mancano dei frammenti




Data Carving di un immagine JPEG

Short Name Bytes Payload Name

SOl Ox FF D8 none Start of Image

SOF0 Ox FF CO variable size Start of Frame (Baseline DCT)
SOF2 Ox FF C2 variable size Start of Frame (Progressive DCT)
DHT Ox FFC4 variable size Define Huffman Table(s)
DQT Ox FF DB variable size Define Quantization Table(s)
DRI Ox FF DD 2 bytes Define Restart Interval

SOS Ox FF DA variable size Start of Stream

RSTn Ox FF DO...0x FF D7 none Restart

Appn Ox FF En variable size Application-Specific

cOM Ox FF FE variable size Comment (text)

EOI Ox FF D9 none End of Image

Figure 1. File structure of a JPEG file.

00000 FFEO 0010 4A46 4946 0001 0201 0048 [Rya..JFIF.....
00010 0048 0000 FFE1 3846 4578 6966 0000 4D4D .H..YASFExif..MM

Figure 2. JPEG header.

38710 D2CF F857 F4DC 1F18 F77F 1F17 2FF6 25‘! OfewWal. .=

Se720] - g

Figure 3. JPEG footer.




Analisi: timeline

Spesso e necessario ricostruire la cronologia delle attivita che hanno
determinato lo stato del dispositivo con ’obiettivo di individuare gli
elementi di prova che concorreranno a dimostrare o confutare dei fatti.

Occorre creare una linea temporale relativa agli eventi verificatesi e
richiede l’integrazione delle varie informazioni temporali (timestamp)
create dal sistema operativo, dal file system e dalle applicazioni utente.

* Metadata dei file (timestamp della creazione, ultimo accesso ed ultima modifica dei file)

» Esecuzione dei programmi (S.0. registra informazioni sull’esecuzione dei programmi)

» File prefetch su Windows
» Registro di Windows
» File log di sistema ....

» Artefatti generati dai programmi ad ogni esecuzione

» Elenco file aperti o salvati
» File di cronologia di navigazione
» File di log ....



Dati del provider

Email

Log dei portali

Interazione con altri
utenti o device

Sincronizzazione
dei dati




Valutazione

La valutazione e una fase necessaria per stabilire:

 Se il reperto informatico e stato
- alterato
* inquinato
« contraffatto
» Se le procedure di acquisizione sono state legittime

 Se il reperto e
» attendibile
* integro
» Autentico

* || significato dei dati presenti sul supporto




Presentazione

La presentazione e |’elemento con cui si valuta tutta l’attivita svolta.
Essa deve comprendere in maniera dettagliata:

 Le fasi dell’analisi

* Le metodologie applicate

Gli strumenti utilizzati

| risultati ottenuti
» Integrando con gli allegati

» Foto dei reperti

La risposta al quesito




Esercitazione

Creazione di una copia forense
Analisi della copia forense
Recupero dei file cancellati
Ricostruzione di una timeline
Esecuzione del data carving




Creazione di una copia forense

Su Kali Linux

1. Identificare il device

» Isblk (vedere dischi e partizioni)

» |susb (vedere periferiche USB)

» fdisk -1 (vedere tutte le partizioni)

» file -s /dev/sdx

» df -h (spazio libero)

* hdparm -l /dev/sdx (info device)
2. Clonare il device

» dcfldd if=/dev/sdx hash=md5,sha256
md5log=md5.txt sha256log=sha256.txt
of=driveimage.dd

» file driveimage.dd

Su Windows (FTK Imager Lite)

1

Identificare il device

 Selezionare File>Add Evidence Item
» Navigare l’albero proposto

Clonare il device

» Selezionare File>Create Disk Image
» Scegliere Physical Drive

» Selezionare il drive da clonare

» Aggiungere la destinazione:
1. Raw(dd) oppure EO1
2. Cartella di destinazione
3. Nome file dell’immagine

4. Livello di frammentazione

Dump Memoria

1. Selezionare File>Capture Memory




Analisi della copia forense

Su Kali Linux Su Windows
1. Autopsy Forensic Browser 1. Ftk Imager Lite
 http://localhost:9999/autopsy 2. ldentificare il device
* New Case » Selezionare File>Add Evidence Item
» Add Host * Navigare ’albero proposto
» Add Image (driveimage.dd) 3. Autopsy 4.6.0
* Analyze « New Case
* File Deleted « Add Data Source (driveimage.dd)
» File Activity TimeLines « Run Module

* Navigare 'albero

» Timeline




Esecuzione del data carving

Su Kali Linux
1. Foremost -i driveimage.dd

2. Si puo scegliere i tipi di file con il
parametro -t (es. -t doc,xls,pdf)

3. | risultati sono riversati in /Output

Su Windows
1. Aprire qphotorec_win.exe
2. Aggiungere un immagine raw
3. Selezionare il disco/partizione
4

. Scegliere se leggere solo lo spazio
libero oppure tutta la partizione

5. Scegliere la cartella dove registrare
i file recuperati




Altre evidenze

Tools per trovare altri artefatti di interesse investigativo:

 DEFT - Digital Evidence & Forensics Toolkit (www.deftlinux.net)
» Distribuzione Linux con tools per la Digital Forensics e I’Incident Response

* DART - Digital Advanced Response Toolkit (www.deftlinux.net)

» Tools per Windows per la Digital Forensics e I’Incident Response

* NIRSOFT Package (www.nirsoft.net)

» Password Recovery Utilities
* Network Monitoring Tools

« Web Browser Tools

* Video/Audio Related Utilities
* Internet Related Utilities

» Desktop Utilities

» Outlook/Office Utilities

» Disk Utilities

» System Utilities




Conclusioni

Considerazioni finali
Aspetti legali




Criticita

. Continuo sviluppo tecnologico
Crittografia
Virtualizzazione
Giurisdizione
BYOD (Bring your own device)

1

2

3

4

5

6. Network Forensics
/. Web Forensics

8. Cloud Computing Forensics
9. Mobile Device Forensics

1

0. loT Forensics




Captatori Informatici

L’utilizzo della crittografia per la memorizzazione dei dati (memorie di massa o
mobile device) e la trasmissione delle informazioni rende complesso, se non
impossibile, I’estrapolazione/cattura dei dati.

Una alternativa e quella di utilizzare i cosiddetti Captatori Informatici, ovvero
dei RAT, un trojan per accesso remoto - Remote Access Trojan, che consente il
controllo della apparecchiatura da remoto.

Installazione/inoculazione é effettuata con le tecniche di hacking.

Un RAT consente di gestire tutte le funzionalita offerte dal device con i
permessi di root ed acquisire tutte le informazioni presenti, p.e.

Occorre fare attenzione ai limiti
legali (non é consentito fare tutto)
ed alle autorizzazioni.



Acquisizione a distanza

Nel caso in cui le evidenze si trovano su un server remoto raggiungibile e
possibile effettuare un acquisizione da remoto. P.e.

» Una pagina web

« Un post su un Social Network

* Un’email

« Un contenuto su cloud sotorage (Dropbox, Google Drive, ecc.)
* Un contenuto multimediale (Youtube, ecc.)

Occorre fare molta attenzione a:

 Permessi di accesso

* Proprieta dei dati




Big Data & Artificial Intelligence

La crescente mole di dati acquisiti e da analizzare puo richiedere |’uso di
tecniche di gestione dei Big Data e dell’Intelligenza Artificiale.

Le prime aiutano a filtrare le informazioni pertinenti all’indagine.

Le seconde facilitano le ricerche, riducono il tempo dell’indagine ed
evidenziano le connessioni tra i vari dati.




Conclusioni

Il reperto informatico e molto delicato e i dati in esso contenuti sono
estremamente volatili.

Pertanto le attivita esposte:
« Necessitano di rigore scientifico nel trattamento di dati informatici

 |n determinati contesti portano inevitabilmente all’alterazione del dato

e per esempio le date di accesso
 Si perdono alibi
« Si perde consapevolezza
 Si perdono prove!

Infine, occorre ricordarsi che tutte le attivita ed i risultati ottenuti andranno a far
parte di un procedimento giudiziario, per cui € necessario conoscere le procedure
legali ed i vincoli imposti dalla normativa vigente.
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Spesso |’attivita di digital forensics e svolta nell’ambito di un
procedimento giudiziale e puo essere finalizzato a:

« Effettuare accertamenti tecnici durante le indagini preliminari
» Ripetibili
» Non ripetibili

e Rispondere ad un quesito tecnico nelle altre fasi del processo

L’incarico puo essere assegnato da un qualsiasi attore del procedimento:
» Giudice -> Consulente Tecnico d’Ufficio (CTU)

» Pubblico Ministero -> Perito del Pubblico Ministero

« Parte Privata -> Consulente Tecnico di Parte (CTP)

* Polizia Giudiziaria -> Ausiliario della Polizia Giudiziaria
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